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Safety Precautions

Safety Precautions

Due to the nature of this product as an assembly kit, consequences, damage , or injury resulting from the use of
this product are the user's responsibility. Please use this product with that in mind. In order to prevent danger

to the user and others, as well as property damages, the safety precautions listed below must be followed.

The following signs are used with each description to indicate the level of potential harm that may be
caused by ignoring the precautions.

-
A DANGER : This sign indicates that "there is imminent danger of death or severe injury".
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A WARNING : This sign indicates that "there is a possibility of death or severe injury".

-
A CAUTION : This sign indicates that "there is a possibility of injury or material damage".

The following graphics are used with corresponding descriptions according to the type of precaution.
(The following are only part of the graphics used in this manual.)

N

: This pictorial indication signifies that the action is "prohibited".

: This pictorial indication signifies that the action is "mandatory".
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o




Safety Precautions

A DANGER

Work with sufficient space in a physically and emotionally alert and observant state.
There is danger of death or serious injury by unexpected accidents.

AWARNING

e N
Keep all parts away from small children.

Parts such as aluminum frame brackets can cause injury.

Disconnect the HV battery connector immediately if any thing abnormal occurs.

*Damage in the robots body. *Foreign objects in the robots body. *Smoke. *Odd smell. *Ab-
normal heat or warmth. Continued use under such conditions can result in fire or electric
shock.

*Should any abnormalities be observed, immediately stop using the product and contact our
service section.

Do not break the charger and cable.

Do not damage, modify, bring in close contact with thermal appliances, or use under forced
pressure. Continuous use under such conditions can result in fire or electric shock.

*For repair of cords and cables, please contact our service section. *If the product becomes wet, please consult our service section.

Disconnect the power plug from electrical outlets when the charger is not being used.
When plugged to an outlet, a small amount of electricity flows into.

Do not disassemble or modify the servo or board of the finished product.

Disassembly and repair, other than those stated in this Instruction, is prohibited. Incorrect dis-
assembly or assembly can cause malfunctions, fire and/or electric shock.

*In case of any malfunction, please contact our service section.
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Do not allow the product to become wet or use under high humidity and conditions where dew condensation occurs.

Such conditions may result in malfunction since this product is composed of electronic parts.
Such conditions can also result in electric shock and fire by electrical shorting.
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During operation, always exercise caution and be prepared for unforeseen accidents.

Please always remember that due to the nature of this product as an assembly kit, safety is
not guaranteed for the movements resulting from the operation of the product. Please take
extra precautions since an injury of the fingertips and fracture of bones may result when
movements of the product greatly differ from what you expect.

Recognize the possibility that components can short circuit.

Short circuit can easily occur since control board terminals are bare. Short circuits can cause the
battery, components, and wiring materials to ignite. Incorrect wiring can also result in similar danger.




Safety Precautions

A CAUTION

For overseas use, local approval or license may be needed. Please check.
In certain areas or countries, legal procedures may be necessary prior to using the product.
*Qur support does not apply to the use of this product outside of Japan. )
- - \
When detaching the charger and battery, firmly hold the connectors.
o Detachment by holding the cord may cause breaking of wires and a possible short circuit,
which can result in electric shock or fire. )
N
Do not operate on an unstable work surface.
The product can lose balance and collapse or fall off causing injury.
J

The HV battery included with this product is a nickel-metal hydride bat-

tery. To protect valuable environmental resources, used batteries should
be recycled, not disposed of as trash.




HV Battery Handling

HV Battery Handling

In this kit, a HV battery (nickel-metal hydride battery) is used as the operational power source. Although the
nickel-metal hydride battery is a secondary battery that can be recharged and reused, misuse can result in
serious accidents. This Instruction should be read carefully before use.

How to charge

1:
Plug the charger (MX-201) into an electrical outlet.

* Do not attach battery before plugging the charger %

into the outlet since that can cause a malfunction.

A |

* The charger is exclusively for AC 100 V,
Electrical current runs through the cord to the termi- and is used by plugging to a house-

nal pins when connected to the charger. Do not hold AC outlet.
short circuit the pins with any conductive material.

Charger (MX-201)

2:

Insert the HV battery connector into the char-
ger connector. The charger LED will turn red
and charging starts automatically.

ANGER

Check the polarity. Never connect with reverse polarity.

WARNING

Beware of the state of the nickel-metal hydride bat-
tery while charging. Should you detect any abnormal
heat, noise or smell, unplug and remove the nickel-
metal hydride battery immediately.

Charger (MX-201)

* Check the polarity. Never connect with reverse polarity.
* Plug in firmly to avoid disconnection while charging.
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3:

The LED will turn green when charging is
completed. Disconnect the charger connec-
tor and the battery connector. Unplug the
charger from the outlet if you don't need to
charge another battery immediately.

Charging : RED
Charging is completed : GREEN

* Charging time depends on the nickel-metal hydride
battery charge remaining. Charging time for an
empty battery is approximately one and a half
hours.




HV Battery Handling

How to charge after discharge

1:
Plug the charger (MX-201) to an outlet.

* Do not attach the battery before plugging the charger
into an outlet because this can cause malfunction.

X
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Electrical current runs through the cord to the terminal pins when connected
to the charger. Do not short circuit the pins with any conductive material.

2:
Insert the HV battery connector to the charger connector. The char-
ger LED will turn red.

* Plug in firmly to avoid disconnection while charging.

ANG

Check the polarity. Never connect with reverse polarity.

3:
Press and hold the charger yellow button. The charger LED will turn
from red to orange and battery discharging begins.

* Discharge time depends on the remaining amount of battery charge, but will take
about five hours at most.

* In order to force charging to begin, press and hold the yellow button. The LED
will change from Orange to Red and charging will begin.

4:
Charging immediately begins when discharging is completed. The
charger LED will turn from orange to red.

* The LED intensity will darken as charging proceeds, but will not dim completely.

WARNING

Beware of the state of the nickel-metal hydride battery while charging or dis-
charging. Should you detect any abnormal heat, noise or smell, unplug and
remove the nickel-metal hydride battery immediately.

5:

The LED will turn green when charging is completed. Disconnect the
charger connector and the battery connector. Unplug the charger from
the outlet if you don't need to charge another battery immediately.

* Charging time depends on the nickel-metal hydride battery charge remaining.
Charging time for an empty battery is approximately one and a half hours.

—

Charger
(MX-201)
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Press down on the
yellow button for a
while.
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HV Battery Handling

Precautions for Use

A DANGER

® : The following actions are dangerous and are prohibited.
\ J
~

Removal of the connector and modification such as changing of cords.
Do not short circuit the battery.
Short circuiting a battery can result in explosion, fire, and fluid leakage, which could cause

injury and loss of eyesight. Short circuits can occur at pins even with connectors attached.
Care and attention are always required during use.

Do not place the battery along side other objects during transportation and storage.

Short circuits caused by damage to connectors, wires or the wrapping of nickel-metal hy-
dride batteries can result in fire and fluid leakage. Please keep batteries separate from other
objects during transportation and storage. There have been reports of fire caused by batteries
short circuiting with coins and car/house keys.

AWARNING

0 : Should the following circumstances occur, take necessary.

ﬁ

In case of fluid leakage, any liquid on your hands or skin must be washed
away immediately. Should you get any fluid in your eyes, wash thoroughly
and seek medical attention.

The substance inside the battery is harmful and can affect the human body, as well as

damage furniture and other household objects. Immediate attention is required as blindness
can be caused if the battery fluid gets in the eye.

Unplug the battery connector from the board and charger when battery is
not in use or when the battery is left unattended for a length of time.

To take necessary precautions in case of unexpected circumstances, always keep the battery in
clear view. Do not leave the connector plugged for a long period of time as it may result in fire.

A CAUTION

‘ 0 In order to protect valuable environmental resources, please take any used

batteries to the store for recycling instead of disposing them as trash.




HV Battery Handling

Nickel-Metal Hydride Battery Properties

Compared to dry-cell batteries, nickel-metal hydride batteries have the advantage of very low internal
resistance and can produce large currents. On the other hand, if battery charging is attempted before the
remaining charge is fully depleted, a condition called memory effect can occur. This can decrease the battery
life span. In order to avoid memory effect occurring, nickel-metal hydride batteries should be recharged only
after they are fully discharged.



Preface

Preface

Thank you for purchasing the "KHR-3HV" robot assembly kit.

This kit enables you to assemble a bipedal robot that can be operated and programmed to perform a wide
range of motions. For its assembly, please read this Instruction, as well as the attached Operation Manual,
carefully. In addition, we recommend that the instructions be printed out as necessary.

Caution

1:

Please keep in mind that due to the nature of this product as an assembly kit, the motion of the assembled
product cannot be guaranteed. Further, due to the fact that the movements of the assembled product depend
in large part on the method by which it was assembled, we may not be able to provide precise answers to your
questions regarding operations.

2:

This product is constructed for people of all ages to enjoy a bipedal robot. However, this product is not a toy,
and contains parts and tasks that would be difficult for young children to understand or perform. For those
parts and tasks, parents or teachers should provide assistance.

3:

The assembly and operation of this product requires the use of a personal computer (Windows XP(SP2) or
Vista) with a USB port. It is assumed that the user has basic computer skills. Please note that we cannot
provide answers to general questions or inquiries regarding computers or Windows.

¢ All company names, trade names, and logo marks that appear in this Instruction are trade marks or
registered trade marks of each respective company.

¢ The contents of this Instruction and product are subject to change without notice for improvement or
other reasons.



Preface

Preparation

The following items are required for the assembly and operation of this product:

¢ Personal computer

Processor : Pentium 4 2GHz or above, or equivalent
: Microsoft Windows XP (SP2 or later) or Vista operating system
Hard Disk : 32 MByte or larger (not including data files)

Memory : 256 MByte or larger

Drive : CD-ROM drive (for installation)

USB 11 or more USB 2.0 port(s)

Software : Microsoft. NET Frame work 2.0 is required
¢ Tools

¢ #0 and #1 screwdriver
Screwdrivers with thick handles and magnetic tips are most convenient.

(< 1 C— ) ’

e small blade

® nippers
for cutting parts and board cover
o file
¢ (4mm) box wrench (or spanner)
for tightening M2 nut
e screw locking adhesive (moderate strength)
convenient for preventing screws and nuts from loosening.

10



Accessories

Accessories

KRS-2552HV

The KRS-2552HV servo motor used in this kit is a FET servo using serial signals. Since the half-duplex serial
transmitting and receiving method is used the servo cables utilize a multi-drop method that decreases the total
number of cables from the control board and allows a simple wiring layout.

¢ A wide range of servo parameters can be set using the ICS USB adapter HS.

¢ Configuration items have been expanded using ICS 3.0 allowing ultra-high speed communication at 1.25
Mbps.

e The servos have been specifically designed for robot use enabling mounting using dual axial support.

e Although the servo size is almost the same as the KRS-788HYV, it can produce much higher output torque.
¢ Utilizing an ultrasonic motor, the servo consumes less power than older products.

¢ Detects temperature and current values for safety.

¢ Major specifications

External size 1 41 x21 x 31.5 (mm) *Not including projections

Weight : 41.5 g * Not including cable and servo horn

Maximum operating angle : 270°

Maximum Torque : 14 kgcm (at 11.1 Vh/ at rest)

Maximum Speed : 0.14 s/60°(at 11.1 Vh/ unloaded)

Rated voltage : Direct current 9-12 V (our specified HV power source is recommended)
RCB-4HV

*Application software is required for its use.

The RCB-4HV control board used in this kit contains eight SIO ports for two systems of ICS3.0 compliant
device, and can connect up to 36 ICS3.0 devices.

With ten AD ports, multiple analog sensors can be used. AD input for power management is available
separately. Ten PIO ports have been mounted. LED may easily be lit. The COM ports and SIO ports are
capable of a maximum speed of 1.25 Mbps. EEPROM, known for its high-speed and high capacity has been
adopted.

. Major specifications * For detailed specifications, see "Heart to Heart4 User's Manual".

Size 1 45x35%x13 (mm) *About equal to RCB-3

Weight 1129

Interface : SIO port, COM port, AD port, PIO port

Rated voltage : Direct current 9-12V (our specified HV power source is recommended)

11



After-sales Service

After-sales Service

¢ Inquiries regarding this product and accessories should be directed to our service section.

Kondo Kagaku co., LTD. Service Section
4-17-7, Higashi Nippori, Arakawa, Tokyo

116-0014

Tel : 03-3807-7648 (Direct line to Service Section)
9:00-12:00 13:00-17:00

excluding Saturdays, Sundays and national holidays

¢ Inquiry by email is welcomed at the following email address; however, please take note that replies may
require some time.

support@kondo-robot.com

¢ Notices and updates regarding this product are posted on our website.

http://www.kondo-robot.com

12



About the Instruction Manuals

About the Instruction Manuals

There are five manuals (instructions) in total for this product.

1.Kit Guidance

The only printed manual. Provides overall description of the kit and how to view the other manuals.

2.KHR-3HV Assembly Instruction Manual

This Instruction. Describes how to assemble the kit.

3.HTH4 Users’ Manual
Provided as PDF file. Describes RCB-4HV and “HeartToHeart4”.

4.KONDO USB Driver Installation Manual

Provided as PDF file. Describes the installation of driver for serial USB adapter HS.

5.IDW Utility Manual

Provided as PDF file. Describes how to use the utility to rewrite servo motor ID.

Instruction and Outline of Assembly

This Instruction provides a step-by-step description covering the assembly of the main body.

Charge HV Battery Before Assembly In this kit, most assembly steps can be completed
simply by tightening screws. However, setting each

servo's origin position correctly is critical. For the first

origin setting of a servo and the steps subsequent to

. . step 6 shown in the left scheme, requires connecting

1 Assembly - Hip Unit the servo motor to the control board, and verifying the
stop position of the initial condition (origin setting).

2 Assembly - Chest Unit

Servo Origin Settings

Please be aware that if the units are assembled

3 Assembly - Arm Unit without setting the origin, the range of servo rota-
tion could differ resulting in abnormal movements,

4 Assembly - Leg Unit malfunction, or damage.

5 Assembly - Sole Unit Therefore, before starting assembly, please charge the

HV battery so that it will be ready when necessary.
£ CEEII (FE U When tightening multiple screws to assemble a part or
sub assembly, all the screws should be temporarily
screwed in lightly and then tightened further after all
the screws are installed.

7 Entirety and Wiring Assembly

8 Assembly - Backpack

If individual screws are tightened separately in the be-
9 Overall Assembly ginning, subsequent screws may not fit into the holes
or may deform the parts.
10 Setting the Home Position

13



Component List

Component List

* Before beginning assembly, make sure that all parts in the quantities shown are present.

* Some parts are similar in shape. Please check the drawings carefully to correctly identify each part.

T~

M .
2ES
S STy
S NS Rk 2
YHR-B1 YHR-C2 YHR-F1-2 HV Charger HV Battery
Dummy Servo Front Cowl (SD1) (1) MX-201 (1) 9N 800mAh (1)
2500A (7)

YHR-001 YHR-002 YHR-003
Body Frame F (1) Body Frame B (1)

YHR-004
Shoulder Frame L (1)

Shoulder Frame R (1)

YHR-005 YHR-006 YHR-007
Body Base (1)

YHR-008
Servo Bracket A (6) Elbow Joint A (2)

Offset Arm La (1)

YHR-009
Offset Arm Ra (1)

The side with this line
is the front side.

YHR-010

YHR-011
Side Joint L (2)

Side Joint R (2)

YHR-012

YHR-013
Leg Joint L (2)

YHR-014
Leg Joint R (2)

Leg Joint B (2)

YHR-015 YHR-016 YHR-017 YHR-018
Foot Angle A-L (1) Foot Angle A-R (1) Foot Angle B-L (1) Foot Angle B-R (1)

14
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Component List

Parts Bag A Parts Bag B

YHR-F1-1 YHR-E1-1 .. ‘ YHR-E1-6
Base Plate A PCB Base B Board Cover (SD1) Cable Guide
(1) (1) (1) (2 sheets)

Parts Bag C I Parts Bag D Parts Bag E Parts Bag F
‘ |
o~=%

YHR-A1-1 YHR-A1-2 YHR-A1-3 YHR-A1-4 YHR-A1-5
Joint Base 2500A Upper Arm 2500A Bottom Arm 2500A Small Diameter Horn Free Horn 2500B
(10) (10) (10) (Offset 0) (12) 4)

Parts Bag H Parts Bag |

—
Ay miv A
S

YHR-C1 YHR-D1-1 YHR-D1-2 YHR-D1-3 YHR-D2
Arm Supporter 2500A Hand Base B Knuckle B Thumb B Cable Guide (small)
(7) (2 (2 (2 (2

Parts Bag J Parts Bag K

7o = /
o QO |
—'/
YHR-G1-1 YHR-G1-2 YHR-G1-3 YHR-F2-1 YHR-F2-2 YHR-F2-3 YHR-F2-4
Battery Holder A Retainer B Parts Mount A Head Base A Face (SD1) Helmet (SD1) Visor (SD1)

(2) (2) (2) (1) (1) (1) (1)

Parts Bag L

YHR-E1-2 YHR-E1-3
Top Pannel B Top Cover B
1) (1)

Parts Bag M < (D &smal Extension Cable

YHR-E1-5
Wing B-R
(1)

Nylon Strap Length=1.5m
% Body Pin %
= (6) HV Power Source Extension Cable
Battery-Holding Sponge Switch Harness Serial USB Adapter HS Length = 100 mm
(1 sheet) (1) (1) (1)

15



Component List

Parts Bag N

2.3-6BH Tapping Screw
(16)

v ¥

Parts Bag O

2.6-10BH Tapping Screw
(24)

Parts Bag P

2.6-6 Flat Head Screw
(18)

Parts Bag Q

M3-8 Low Head Horn Screw
(24)

Parts Bag R

2-5 Low Head Tapping Screw
(200)

§ £

Parts Bag S

2-8 Low Head Tapping Screw
(43)

Parts Bag T

M2-4 Low Head Screw
(38)

L} ¥

Parts Bag U

M2-6BH Screw
(26)

LI |

Parts Bag V

M2 Nut
(10)

@ ©

[amms]

Parts Bag W

2-6 Flat Head Tapping Screw

(10)

Parts Bag X

3-6 Flat Head Screw
@)

Connection Cables

@
e

@®

@

ZH Connection Cable A (ZH/ZH Connector) 50 mm

ZH Connection Cable A (ZH/ZH Connector) 100 mm

fieee———rcm=————=—oIN

ZH Connection Cable A (ZH/ZH Connector) 200 mm

i\

ZH Connection Cable B (ZH/Servo Connector) 100 mm

@

Fe—r—ro—r———N%1

ZH Connection Cable B (ZH/Servo Connector) 200 mm

@

)

ZH Connection Cable B (ZH/Servo Connector) 300 mm

@

i '

ZH Connection Cable B (ZH/Servo Connector) 450 mm

@

= ————o—no———E
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Prior to Assembly

Prior to Assembly

Servo Motor (KRS-2552HV) Parts Names

Upper Side

Upper case

M3 Screw Hole

(depth: 8 mm)

Output Axis (upper axis)

Servo Case Middle case

Bottom case

174

AN

\g
./

The rotational axis that outputs
power inside servo. Used by
securing parts such as servo
horn and servo arm to the
serration (notches surrounding
the output axis).

Serration
(seen from above)

Bottom Side

Bottom Axis

Housing Guide =—p

(marker to avoid inversion)

Signal

- (GND)

1 OOO |
444
1 1 L
(Vee)

+

Housing

Case Screw

Free rotational axis that assists
support of parts. Used by secur-
ing parts such as free horn and
bottom arm.

2.6 Screw Hole

(depth: 6 mm)

Screw for securing servo case.
Is removed once during
assembly process, and used
to secure frame and bracket.

20




Prior to Assembly

Types of screws and how to handle them

¥

Screw

(coarse metric screw)

Characteristics

In the present kit, this screw is mostly used
for securing aluminum parts together. (The
"M" inscribed in the name of the screw indi-
cates that it is a JIS standard metric screw.)
This type of screw fits only in tapped hole.
(You can see indentations matching the
screw inside the hole.) This type of screw
can be used repeatedly unless it wears out
or deforms.

( Y 4 Y

RightQ>

When using several
screws to secure
parts, first tighten
each screw lightly, and
then tighten them
further to secure the
parts evenly with equal

Further, when using more than four
screws to secure parts avoid adding
uneven pressure to the parts by alter-
nately tightening screws that are
diagonally aligned.

force.
«i i «i i. ¢ e ar
Tighten Tighten
lightly further ) )
(Example or tightening order)
. J . J

Tightening Suggestions

Be careful not to break the screw head with a screwdriver. (Using a poorly fitting screwdriver
with the wrong size, and over-tightening can destroy the screw head.)

Replace the screw with a new one when its head is destroyed, since it will become impossible
to remove with a screwdriver. When the screw stops while tightening, check to make sure that
the screw is not bent. Continued use of a bent screw can cause deformation of the tapped
hole, and will become impossible to tighten even when using new screws.

Maintenance

Vibration causes screws to eventually loosen, even if the screws are tightened securely.
Check regularly that the screws are not loosened even after assembly is completed. If you
find that the screws loosen or fall off frequently with motion, screw locking adhesives (such as

Loctite® and Screw-Lock) can be effective.

*When using locking adhesive, follow instructions attached to the adhesive.
Beware that securing screws with instantaneous adhesive can cause the screws to be perma-

nently locked or the holes to be clogged.

[

Tapping screw

Characteristic

This type of screw is used to secure plastic
and some aluminum parts. The tapping
screw thread is tapered and drill-shaped,
and can secure parts by tapping threads into
holes that have diameters smaller than the
screw. (The action of cutting a spiral groove
for the screw ridge to fit in a hole is called
“tapping”.) Because the screws are tapped
into the parts, they can be fastened more
tightly than normal screws (metric screws),
but will require more force to tighten them in
the beginning. If the tapping screws are
tightened and removed repeatedly, the holes
will become larger and the screws may easily
loosen.

Tighten
while adding pressure.

Tightening Instructions

(1) Confirmation of screw holes

Before tightening tapping screws, always
check to see if their positions and shapes
are as shown in this Instruction.

* If tapping screws are screwed into normal
screw holes or holes of ill-fitted sizes, the
screw holes can deform, making it impos-
sible to screw in the correct ones.

(2) Tapping

Tighten the tapping screw by pushing its
head with a screwdriver so that the screw
stands vertical.

* If screws are tightened too hard into plastic
parts, the screw head may become embed-
ded and deform. Tighten with care.

21

Retightening a screw after re-
moving it

If a tapping screw is removed after tighten-
ing, grooves are already formed in the hole.

Thus, retightening should be done as
follows:

(1) Position the screw vertically

Rotate the screw counter-clock-wise before
tightening to make sure it is positioned verti-
cally.

(2) Screw in without pushing

Tighten it as with normal screws (metric
screws).

* If you push the screw, the holes will be
damaged and it will become impossible to
secure the screw.



Prior to Assembly

Servo and channel identification

4 N\ How to secure servo cable 50 50
decals ‘ ‘ ‘ ‘ ‘
X . . Sio [si0 ==
Cutting the decal with a cutter or scis-
sors beforehand makes it easier to & =
handle.
Q E:> ﬂ Cut decal as you like with reference to For attaching the channel number, refer
. B the left drawing. to the “Process of Assembly” section or
K j the “List of Channels” shown below.
List of IDs for KHR-3HV
For the assembly of this kit, each servo with
attached IDs are used as shown in the following .
layout figure.

.......................................

HEEEE 85—

Can be expanded from 17 axis to 22 axis
using five KHR-3HV expansion sets.

* This is a frontal view.

22



Preparation

Preparation

1. Charging The Battery

Battery should be charged beforehand.
See p 5-8 for charging methods.

In this kit, HV battery (Nickel-metal hydride battery) is used as a power source for operation. Charging typically
takes about an hour and a half. The following sections refer to processes that use battery. While the battery
is charging, install the exclusive “HeartToHeart4” software and the serial USB adapter HS driver, as well as
reading all the instructions. Further, process 4 (Assembly of Chest Unit) and the subsequent 16 processes can
be done in advance under your own judgment and responsibility.

* Be attentive and prepared for any abnormalities while charging the battery.
** Stop all use immediately if abnormal heat or an odd odor is noticed.

23



Preparation

2. Setting Servo Origins

Securing parts to servo output axis and precautions

Mounting Small Diameter Horn

Origin Setting is an important pro-
cess that decides the reference
point of the servo rotation angle.
Accurate origin setting will result in
high reproducibility of sample mo-
tions. EuLF

good example

There is only one mounting direction for
the servo arm, so if it does not exactly
match the figure, shift it slightly to either
the right or left. For instance, when
setting the origin of servos in both shoul-
ders, the more offset there is between the
left and right shoulder servo origins, the
-- more uneven the arms of the robot will be.
Try to assemble by carefully finding the
best positions.

good example
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Assembly - Control Unit

¢ Required Parts

||
RCB-4HV 1 .
PCB base B 1 .m- B
2-5 Low head tapping screw ------ 2 E E
Power switch harness -------------- 1

2-5 Low Head
Tapping Screw

Temporarily Secure RCB-4HV to PCB base B using two
2-5 Low Head Tapping Screws.

* The screws will be taken off in a later process. The 2-5
Low Head Tapping Screws should be screwed on tem-
porarily.

RCB-4HV

/
~

Connect the Power Source Switch Harness to the RCB-

Power Supply 4HV power terminal.
Switch Harness

The power switch on the Power Source
Switch Harness must be turned OFF at
all times unless directed otherwise. If
the switch is turned ON, the robot may unexpectedly

move and fall off, break, or cause injury when connected
to a power source.

The connector is shaped so as to avoid reverse
B3 connection. Do not force the plug in incorrectly, as
this may result in the connector breaking.

J
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Setting Servo Origins

Servo-motor KRS-2552HV used in this product has a maximum operation angle of approximately 270 degrees.
Like human joints, it does not turn limitlessly and is restricted in its angle of motion. For the robot to operate
properly, it must be assembled taking into consideration its mechanical restrictions and actual operation.

Setting the origin of the servos is important in this respect.

If the origin is not correct, it might not operate properly when performing sample motions. Therefore, please
understand the origin setting method and proceed carefully.

The origin must be set each time a servo arm is mounted on a servo.
Whenever origin setting is called for, the following process must be performed.

1. Things to prepare
Control Board RCB-4HV mounted on PCB base B in the preceding process is used.
The “HV battery 9N-800mAh” is used as the power source for RCB-4HV. Please charge beforehand. See p4-6
for charging method.
Furthermore, the motion creation software “Hear tToHeart4” must be installed in a personal computer.

Connect the RCB-4HV to the personal computer using the attached Serial USB Adapter HS and the Serial
Extension Cable. Drivers should be installed in advance.

HV battery Serial extension cable
9N-800mAh —

Control unit Serial USB adapter HS
e For detailed description on the use of RCB-4HV, software and Serial USB Adapter HS, see “HTH4 user’s
manual”.

® The personal computer should run Microsoft Windows XP or Vista.

Plug to the USB port of your computer after connecting
Serial Extension Cable to serial USB adapter HS.
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2. Confirm COM port for Serial USB adapter HS.
Connect serial USB adapter HS to the USB port on your computer.

* When connecting for the first time, “Add New Hardware Wizard” runs.
Complete the setup according to the KONDO USB Driver Installation Manual.

When installation of the driver for Serial USB adapter HS is completed, confirm the “COM Port Number”. This
number is important when using the software, so write it down.

1. "Right click" on MY COMPUTER.
2. Select "Property".

* This description is based on Windows XP.

3. Click on the “Hardware” tab in the “System
Property” window.

| &8 | oota—sg NP Besisr= | vATLOEL | B8 EE | VE-F
H
FIAL Th—Ty
FI A TR—Upld, TR VAP ENTUSEATON—E

Iy :rs"rl'P‘\Eﬁ‘T'béE"g’ THAA T3 —UrREST BT ADT
OMTEEBTEEY.

[ FIHA AT ]

B BMEBER(E, A2 = )LENTOE B O Windows SDE
Peai i TEE . B AT Windows Update ~ 38893
HiEE Windows Update R{F-TERECEET.

( FS DERS ] [

Windows Update i J

Me—FrIF Fo7ed )l

M= |'“"JIJ_" 07 IEESE. BIDN - F PO RS
FooeHTEET,

e

EL. 15

B FHRA2 34—T+v
IrALE EREE RTOW ALTH

4. Click “Device Manager”

5. Click “+” for “Port (COM and LPT)”
in Device Manager and check that

- m S =

SERIAL USB ADAPTER HS is dis-

-6 USE (Universal Serial Bus? Jb0—3
@ F—h—F

R B Wlan b

+ Hensk, BT, LU -L 2003
: DATLTEAL

e TAAD S

-8 FaATLA FETR

[+-E@ AU TR

R WS

B b1 =T AT A FHRAA

- JOf

S -t 00M £ LPT)

played. Confirm the COM number
that appears in the (). * If SERIAL
USB ADAPTER HS does not appear,
either the driver is not installed
properly or the Serial USB Adapter
is not connected to the computer.

&
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3. Connection

1. Connect cable from Serial USB Adapter HS to COM terminal (port) of RCB-4HV.
2. Connect two ZH connection Cable B (ZH Servo Connector) 450 mm to SIO1 and SIO5 of the SIO port.

*Plug so that the signal line
(gray) faces the interior of the,
circuit board.

* Plug so that signal line
(white) faces the interior of
the circuit board.

SI05

Power Supply Terminal

* This side is the con-
nector that is plugged
to RCB-4.

COM Port

second pin from top

(Analog input port AD port) a\VA{SY / g1 —

* not used.

(PIO Port)

* not used.

ZH Connection Cable B | {
(ZH/Servo Connector) 450 mm

|'7|

e Important Issues on Origin Setting

RCB-4 contains two systems of serial ports for servo driving: SIO1-4 and SIO5-8.

SI01-SI04 outputs the same signal and the servo motor operates the same way when connected to any of
them. The same can be said for SIO5-SIO8.

In KHR-3HV, SIO1-SIO4 are used for the left side, and SIO5-SIO8 are used for the right side.

Therefore, servo motors with red and yellow ID decals are operated by connecting the cable from SIO1,
and servo motors with blue and green ID decals are operated by connecting the cable from SIO5.

Left side of body / use SI01 cable

. . . . . . Right side of body / use SI05 cable
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4. Connecting cable to servo motor for origin setting

* Either of the connec-
tion terminals on the
servo motor can be
used.

/

.
\\\/

5 Activate the software

Activate the motion creating software “HeartToHeart4” and prepare for origin setting. If you have not finished
installing ‘HeartToHeart4’, do so by using the CD-ROM provided.

* When first activating the software ‘HeartToHeart4’, a ‘HeartToHeart4’ folder is created automatically in the

My Documents folder on your computer. Project files created must be saved in the “Projects” folder in the
‘HeartToHeart4’ folder.

1. Switch ON the RCB-4 Power Switch.
When motion creation software ‘HeartToHeart4’ is

activated, create a “Neutral Setting” project in the
‘HeartToHeart4’ folder.

2. Click “File” > “New Document” > “Project”

Ty SRR

E y [l Fovmoke | |
)

| E-vaw

BV CERTE I TIRTE A
ETOE-L AT

trator¥hdy Dol
trator¥hy Daocy

=l FOVIOEEFEE
BREIFTI OV Db EIRTE
#HRIDT 1ok

3. In the New Project window, name the new project (=13

“Neutral Setting” . F0Y 10 RIS BIAR
% . . . C#Docunents and Settings¥ Administratorshty | [ |
New projects may be given arbitrary names. Do HEARTTaHEART (——
AT
not change the location for saving files unless e imm [Fa-oniE
necessary. Files are normally saved in the =E.AE=
‘HeartToHeart4’ folder in “My Documents” . = S '
CTTT LBy
4. Click the Import Project button. wonoa
1

29



Preparation

5. Select “Neutral Setting” in “Projects” in the ‘HeartToHeart4’
folder created in “Program Files” .

* Unless changed after installation of software, the
‘HeartToHeart4’ folder is under “C:\Program Files” .

* When ‘HeartToHeart4’ software is installed, Sample Proj-
ects are saved in the “Program Files” folder. The project
for Neutral Setting is inside this Sample Project, so the
Neutral Setting Project must be loaded from the Sample
Project according to the above instructions, and imported
to the New Project as described above.

6. Go back to the New Project Window and Click OK.

7. Select the previously-checked communication port number
(COM).
* Here, COM10 is selected as an example.

8. Select “Project Setting”

* An error message as shown in the right appears when
communication problems occur for reasons such as robot
not being switched ON, or communication port (COM)
number not being selected.

When normal connection is made, the following window ap-
pears.
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9. Set ICS communication speed to 115200. %, ROBA FUT 1 BT
P EECRAM (TI<RAM [ ROMAIRTE - [H#IT 9 Za—k3il X 7+—<ak G UAR—|
VATLERTE

IL-LFIE COMIBISIEEE 0SB

[ #%LED O #R7-Em [ shfrid TOEE

able. 21— LIRA comBisiEn csiBEEE

[l #LED SRT-TIER [ #hi'eid T 0&E ROMIEFEED H—REh{'EeT A

10. When “RAM” button is clicked, the project standard % enee Fnzonh S
values are sent to RCB-4 and the servo becomes oper- ‘t JRo f ROWNRAE - WOBT: 9 23t X7a-wob Gurhch

11. Select the servo motor that needs to be adjusted in HRE R DIEHE

501234

#HRE-L [SI01234 | D D)

“Servo Motor Initial Setting” .
- R
In the following example, the origin for servo “ID 0” . e ‘ -
(red) connected to the SIO1 channel is set. : B =
12. Press “Sync” button and check operation using the po- [¥) #-EnieeTi
sition slide bar.
* Servo moves with slide bar |
= J L
= 0
= E V)
s syl
ER :
13. When operation is confirmed, return position to “7500 — 00—
(origin)” . e R . (=
S v .
* Double clicking the value next to the slide bar auto- - S L
matically changes the value to “7500” . : (G|

14. Turn off RCB-4, plug in another servo that needs origin setting, and repeat steps 9-13.

The above are the process for origin setting. The origin should be set for all servos based on these steps.
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15, When all the procedures are completed, turn off RCB-4 BEE]
and close the “RCB4 Project Setup” window. ;
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Assembly

3. Assembly - Hip Unit

* Required Parts

Dummy Servo 2500A--------------- 3 .i.

Arm Supporter 2500A ------------- 3 i L} =

YHR-005_Body Base -------------- 1 % = = )

YHR-008_Offset Arm La----------- 1 -y = Completed Process Image
YHR-009_Offset Arm Ra----------- 1

2-5 Low Head Tapping Screw ---- 32

3-6 Flat Head Screw --------------- 3

~ N
2-5 Low Head §

2-5 Low Head Tapping Screw
Tapping Screw ?

Arm Supporter
2500A

Dummy
Supporter 2500A
Prepare 3 sets of
the same unit.

@ @

Mount Arm Supporter 2500A (1 each) to Connect the three units prepared in step (1) using four 2-5
Dummy Servo 2500A using 2-5 Low Head Low Head Tapping Screws, as shown in the figure.

Tapping Screws (4 each).
* Make sure the front and back sides are correct.

- J

* Check front
and back direction.
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/

€)

Use four 2-5 Low Head Tapping Screws to secure
the back side of the unit assembled in step (2).

@

Using eight 2-5 Low Head Tapping Screws, mount
the YHR-008_Offset Arm La and the YHR-
009_Offset Arm Ra as shown in the figure. Use two
3-6 Flat Head Screws to secure the center.

3-6 Flat Head
Screw

Offset Arm La

* Check the direction

Offset Arm Ra
* Check the direction

2-5 Low Head
Tapping Screw

2-5 Low Head
Tapping Screw

Mount the YHR-005_Body Base using four 2-5 Low
Head Tapping Screws and one 3-6 Flat Head Screw
as shown.

3-6 Flat Head

Screw
2-5 Low Head

Tapping Screw

oty
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4. Assembly - Chest Unit

e Required Parts

Servo Motor KRS-2552 [ID 0]------ 1 .ﬁ.

Servo Motor KRS-2552 [ID 1] ----- 2 = -- =

YHR-001_Body Frame F ----------- 1 . = = .

ponna Body frame 8 1 - B Completed Process Image
YHR-003_Shoulder Frame L ------ 1

YHR-004_Shoulder Frame R ------ 1

Arm Supporter 2500A -------------- 2

Battery-Holding Sponge ----------- 1

2-5 Low Head Tapping Screw ---- 20
M2-4 Low Head Screw------------- 8
ZH Connection Cable A 200 mm-- 2
ZH Connection Cable A 50 mm --- 1
ZH Connection Cable B 100 mm-- 2

2-5 Low Head
Tapping Screw

2-5 Low Head
Tapping Screw

Arm Supporter Arm Supporter
Servo Case Screw 2500A 2500A
Connection Cable Connection Cable
(ZH Connection Cable A 200 mm) (ZH Connection Cable A 200 mm)

@ @

Take out the Servo Motors  Put Connection Cable (ZH Connection Cable A 200 mm) through the Arm Sup-
with [ID 0] (red), [ID 1] (red) porter, and secure the Arm Supporter 2500 A to the Servo Motors [ID 1] (red)
and [ID 1] (blue), and and [ID1] (blue), using 2-5 Low Head Tapping Screws (4 each).

remove all servo case
screws (4 each). * The direction of the cables differs between the two servos. Check the ID

numbers in the figure.
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/

Using the servo screw removed in step (1), mount the YHR-003_Shoulder Frame L to the Servo Motor
[ID1] (red), and the YHR-004_Shoulder Frame R to the Servo Motor [ID1] (blue). Make sure the direc-
tions of the frames are correct.

* The Shoulder Frames have different
shapes on the left and right. Identify
them by carefully checking the posi-
tion of the holes.

Plug the Cable to the Connector

Shoulder Unit L Shoulder Unit R

Backside View Backside View

\
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@ Connect the Servo Motor [ID 0] (red) to [ID 1] (red) using the
Connection Cable (ZH Connection Cable A 50 mm), then
connect the Connection Cable (ZH Connection Cable B 100
mm) to [ID 0] (red).

* In this process, the length of the cables are important.
Please check carefully.

@ Connect the Connection Cable (ZH Connection
cables are positioned as shown in Figure [A]. (ZH Connection Cable A 50 mm)

Connection Cable — Connection Cable
(ZH Connection Cable B 100 mm) (ZH Connection Cable B 100 mm) %

* Stick a decal for
the servo lead on
ZH Connection
Cable B 100 mm.

Connection Cable 2-5 Low Head
(ZH Connection Cable A 200 mm) § Tapping Screw

Servo Case
Screw

* Cables are strung @
as shown in the left figure Use four 2-5 Low Head Tapping Screws on the
servo output axis side and the four servo case

screws taken off in step (1) on the bottom side.

N Y,
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4 )
Stick one Battery Holding Sponge Using four 2-5 Low Head Tapping Screws
to YHR-002_Body Frame B. and four M2-4 Low Head Screws, mount
the YHR-002_Body Frame B with Sponge
attached, to the unit assembled in step (6).
Make sure the cables are positioned as

shown in Figure [B]

Battery-Holding
Sponge

2-5 Low Head
Tapping Screw

* Stick on to match
the screw holes.

M2-4
Low Head Screw

2-5 Low Head
Tapping Screw

* Make sure the cables are
positioned as shown in the figure.

Mount the YHR-001_Body Frame F using
four 2-5 Low Head Tapping Screws and
four M2-4 Low Head Screws.

2-5 Low Head
Tapping Screw

Body Frame F

2-5 Low Head
M2-4 Low Head Screw Tapping Screw
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5. Assembly - Servo Arm (Shoulder)

e Required Parts

Joint Base 2500A 2 li.
Bottom Arm 2500A ---------=-=---- 2 I'em i

i =l
Small Diameter Horn --------------- 2 Q = = )
2.6-10BH Tapping Screw ---------- 2 i
M2-6BH Screw 8

e )
@ Insert the Bottom Arm 2500A into the Joint @ Mount the Small Diameter Horn as indi-
Base 2500A. cated in the figure and secure using four

M2-6BH screws.
* Check the direction (front / back) of the
Joint Base. Caution: The position of the Small Diam-

eter Horns differ by 90° for each arm.

*check
the front and back
Bottom Arm

2500A Small

Joint Base S o(Wb)o) Diameter (o
2500 A

Check the Prepare two sets
front and back of the same unit.

Secure the connecting parts using one 2.6-
10BH Tapping Screw each.

Prepare two sets
of the same unit.

2.6-10BH

> Shoulder Servo Arm  Shoulder Servo Arm
Tapping Screw (left) (right)

- J
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6. Assembly - Servo Arm (Ankle - Thigh)

e Required Parts

Joint Base 2500A 4 - [ | .
Bottom Arm 2500A ---------------- 4 .- i
2.6-10BH Tapping Screw ---------- 2 il lll

@ Insert the Bottom Arm 2500A into the Joint
Base 2500A.

* Check the direction (front / back) of the
Joint Base.

Bottom Arm
2500A

Joint Base
2500 A

Check the
front and back

Secure the connecting parts using one 2.6-
10BH Tapping Screw.

Prepare four sets
of the same unit.

2.6-10BH
Tapping Screw
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7. Assembly - Elbow Unit L

e Required Parts

Servo Motor KRS-2552 [ID2] ------ 1
Servo Motor KRS-2552 [ID 4]------ 1
YHR-006_Servo Bracket A -------- 1
YHR-007_Elbow Joint A ----------- 1
Dummy Servo 2500A--------------- 1
Arm Supporter 2500A -------------- 1
2-5 Low Head Tapping Screw ----- 16
3-6 Flat Head Screw ---------—————- 1

<GmEn

el | ||
[ ][]
[ [ ]]

Completed Process Image

\
@ Arm Supporter @
2500A
~ L ~
N2
2-5 Low Head l e % 2-5 Low Head
Dummy Servo Tapping Screw Tapping Screw
2500A © -
Elbow Joint A
®
Mount the Arm Supporter 2500A on the Dummy Servo Mount the YHR-007_Elbow Joint A using four 2-5
2500A using four 2-5 Low Head Tapping Screws. Low Head Tapping Screws.

* Elbow Joints can be mounted on the top or
bottom. Check the following figure carefully
and mount accordingly.

2-5 Low Head
Tapping Screw YHR-006_ ;
Servo Bracket A Elbow Joint A
. oY
Make sure Ig o
there is space ©
YHR-006_Servo Bracket A 3-6 Flat Head at the bottom.
Screw oFlp |
Mount the YHR-006_Servo Bracket A using four 2-5 Low
Head Tapping Screws and one 3-6 Flat Head Screw. Side View
/
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/

Unscrew the two case screws on the bottom
from the Servo Motor [ID 2] (red).

Servo Case
Screw

2-5 Low Head
Tapping Screw

Take two of the case screws on the right side
(viewed from the bottom side) of Servo Motor
[ID 4] (red).

Servo Case
Screw

2-5 Low Head
Tapping Screw

\

Mount the Servo Motor [ID2] (red) to the unit
prepared in step (3). Use two 2-5 Low Head
Tapping Screws on the servo output axis
side, and the two servo case screws taken
off in step (4) on the bottom side.

®

Servo Case
Screw

Mount the Servo Motor [ID 4] (red) on the
parts prepared in step 5. Use two 2-5 Low
Head Tapping Screws on the servo output
axis side, and two servo case screws taken
off in step (6) on the bottom side.

@

r

.

Be careful not to tighten the case screws too hard.

* Check the direction carefully when
mounting the Servo Motor.

&
\ Servo Case
N A Screw
y,
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8. Assembly - Elbow Unit R

e Required Parts

Servo Motor KRS-2552 [ID2] ------ 1
Servo Motor KRS-2552 [ID 4]------ 1
YHR-006_Servo Bracket A -------- 1
YHR-007_Elbow joint A ------------ 1
Dummy Servo 2500A--------------- 1
Arm Supporter 2500A -------------- 1
2-5 Low Head Tapping Screw ----- 16
3-6 Flat Head Screw ---------—————- 1

~En
= | |

Completed Process Image

\
@ Arm Supporter @
2500A
~ L ~
N2
2-5 Low Head l e % 2-5 Low Head
Dummy Servo Tapping Screw Tapping Screw
2500A © -
Elbow Joint A
®
Mount the Arm Supporter 2500A on the Dummy Servo Mount the YHR-007_Elbow Joint using four 2-5
2500A using four 2-5 Low Head Tapping Screws. low head tapping screws.

* Elbow Joints can be mounted on the top or
bottom. Check the following figure carefully
and mount accordingly.

2-5 Low Head
Tapping Screw YHR-006_ :
Servo Bracket A Elbow Joint A
. oY
Make sure Ig o
there is space ®
YHR-006_Servo Bracket A 3-6 Flat Head at the bottom.
Screw | SR
Mount the YHR-006_Servo Bracket A using four 2-5 Low
Head Tapping Screws and one 3-6 Flat Head Screw. Side View
J
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/

\

Unscrew the two case screws on the bottom @ Mount the Servo Motor [ID 2] (blue) to the

from the Servo Motor [ID 2] (blue). parts prepared in step (3). Use two 2-5 Low
Head Tapping Screws on the servo output
axis side, and two servo case screws taken
off in step (4) on the bottom side.

Servo Case
Screw

Servo Case
Screw
Cd
2-5 Low Head
Tapping Screw
Take two of the case screws on the left side @ Mount the Servo Motor [ID 4] (blue) on the

(viewed from the bottom side) of Servo Motor parts prepared in step (5). Use two 2-5 Low

[ID 4] (blue) . Head Tapping Screws on the servo output
axis side, and two servo case screws taken
off in step (6) on the bottom side.

Servo Case
Screw
Servo Case \
Screw %%2

2-5 Low Head
Tapping Screw

( )

Be careful not to tighten case screw too hard.

* Check the orientaton carefully when

mounting the Servo Motor.
\ Y,




9. Assembly - Arm Unit

Assembly

e Required Parts

Hand Base B 2
Dummy Servo 2500A--------------- 2
Joint Base 2500A 2
Bottom Arm 2500A ---------------—- 2
Joint Base 2500A 2
Bottom Arm 2500A ----------------- 2
2-8 Low Head Tapping Screw ---- 20
2.6-10BH Tapping Screw ---------- 2
Knuckle B 2
Thumb B )

[ |

s

B'em

iz =0

v HE b/

=i ... Completed Process Image
a3 g
=« &

@

Check the
front and back

As in the previous process “Assembly -
Shoulder Servo Arm”, insert the Bottom Arm
2500A to the Joint Base 2500A.

* Make sure to check the direction (front /
back) of the Joint Base.

Bottom Arm
2500A

Joint Base
2500A

Secure the Arm's connecting parts using one
2.6-10BH Tapping Screw.

2.6-10BH
Tapping Screw

©)

Mount the Dummy Servo 2500A as shown in
the figure and secure using four 2-8 Low
Head Tapping Screws. Make sure that the
horn on the Dummy Servo 2500A is on the
same side as the Bottom Arm 2500A.

2-8 Low Head
Tapping Screw

Dummy Servo

2500A
Prepare two sets
of the same.

\
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/

@ Mount the Hand Base B using four 2-8 Low Head Tapping Screws.

Prepare two sets
of the same.

@ Insert the Knuckle B and the Thumb B into the Hand Base B
and secure using two 2-8 Low Head Tapping Screws.

* Take precaution as the orientation of Thumb B differs be-
tween the left and right arms.

% 2-8 Low Head
) Tapping Screw

Thumb B
Knuckle B % 2-8 Low Head
e Tapping Screw

15

2-8 Low Head
Tapping Screw

Hand Base B

Arm Unit L

Arm Unit R

\
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10. Assembly - Thigh Unit L

e Required Parts

YHR-010_Thigh Joint L ------------ 1 .i.
YHR-011_Thigh Joint R ------------ 1 =___=
Servo Motor KRS-2552 [ID 7] ----- 1 e = = 5
Servo Motor KRS-2552 [ID 8]------ 1 ¥

Completed Process Image

2-5 Low Head Tapping Screw ----- 7

=3 'S

4 )

Unscrew three of the case screws from the Unscrew all four of the case screws from the
Servo Motor [ID7] (yellow), as shown in the Servo Motor [ID8] (yellow).
figure.

Servo Case
Screw

Mount YHR-010_Thigh Joint L to the bottom Mount the YHR-011_Thigh Joint R to the
side of servo using the seven servo case output axis side of the servo using seven 2-5
screws taken off in the preceding steps. Low Head Tapping Screws.

* Check the servo ID carefully.

YHR-010_Thigh Joint L
* Check front / back (see parts list)

2-5 Low Head

Servo Case Tapping Screw

Screw

YHR-011_Thigh Joint R
R * Check front / back (see parts list)
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11. Assembly - Thigh Unit R

¢ Required Parts
YHR-010_Thigh Joint L ------------ 1
YHR-011_Thigh Joint R ------------ 1
Servo Motor KRS-2552 [ID 7] ----- 1
Servo Motor KRS-2552 [ID 8]------ 1
2-5 Low Head Tapping Screw ----- 7

[ |

s

B 'em B

T

‘mm’ .

=i B Completed Process Image
~ a
= &

/

Unscrew three of the case screws from the
Servo Motor [ID7] (green), as shown in the
figure.

Servo Case
Screw

Mount the YHR-011_Thigh Joint R to the
bottom side of the servo using the seven servo
case screws taken off in the preceding steps.

* Check the servo ID carefully.

Servo Case
Screw

YHR-011_Thigh Joint R
* Check front / back (see parts list)

YHR-010_Thigh Joint L
* Check front / back (see parts list) @

Unscrew all four of the case screws from the
Servo Motor [ID8] (green).

Mount the YHR-010_Thigh Joint L to the
output axis side of servo using seven 2-5
Low Head Tapping Screws.

2-5 Low Head
Tapping Screw

\
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12. Assembly - Leg Unit L

e Required Parts

Servo Motor KRS-2552 [ID 9]------ 1 .i.

YHR-012_Leg Joint L -------------- 1 = 3 =

YHR-013_Leg Joint R -------------- 1 Q = = "

VHR-014_Leg Joint B -----o--o-oo- ! - B Completed Process Image
Joint Base 2500A 1

Bottom Arm 2500A ----------------- 1

2.3-6BH Tapping Screw ----------- 4

2.6-10 Tapping Screw -------------- 1

M2-4 Low Head Screw------------- 4

2-5 Low Head Tapping Screw ----- 3

2.3-6BH

As in the previous pro- @
Tapping Screw

cess “Assembly -
Shoulder Servo Arm?”,
insert the Bottom Arm
2500A to the Joint
Base 2500A.

Leg Joint R

* Make sure to check
the direction (front /
back) of the Joint

Base. Mount one YHR-013_Leg

Joint R using two 2.3-6BH
Tapping Screws.

Secure using one 2.6-10
Tapping Screw.

2.3-6BH

Tapping
Screw

Leg Joint L

2.6-10

Mount the Arm as- Tapping Screw

sembled in step (1) to
one YHR-012_Leg Joint W
L using two 2.3-6BH
Tapping Screws.
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Assembly

®

Unscrew three of the case screws from Servo
Motor [ID 9] (yellow), as shown in the figure.

Insert the servo so that YHR-012_Leg Joint L
is on the bottom side of the servo and YHR-
013_Leg Joint R is on the output axis side of
the servo. Secure using the three servo case
screws taken off on the bottom side, and
three 2-5 Low Head Tapping Screw on the
output axis side.

Secure YHR-014_Leg Joint B using four
M2-4 Low Head Screws.

* If you find it difficult to mount Leg Joint B,
loosen the three 2-5 Low Head Screws
first, and then retighten.

Low Head Screw

Servo Case

% Screw

2-5 Low Head
Tapping Screw

Servo Case
Screw

M2-4
Low Head
Screw

M2-4
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Assembly

13. Assembly - Leg Unit R

e Required Parts

Servo Motor KRS-2552 [ID 9]------ 1
YHR-012_Leg Joint L -------------- 1
YHR-013_Leg Joint R -------------- 1
YHR-014_Leg Joint B -------------- 1
Joint Base 2500A 1
Bottom Arm 2500A ----------------- 1
2.3-6BH Tapping Screw ----------- 4
2.6-10 Tapping Screw -------------- 1
M2-4 Low Head Screw------------- 4

2-5 Low Head Tapping Screw ----- 3

el | ||
lllll.
[ [ ]]

<SEE

Completed Process Image

As in the previous pro-
cess “Assembly -
Shoulder Servo Arm?”,
insert the Bottom Arm
2500A to the Joint
Base 2500A.

* Make sure to check
the orientation
(front / back) of the
Joint Base.

2.3-6BH

Tapping
Screw

Mount the Arm as-
sembled in step (1) to
one YHR-013_Leg Joint
R using two 2.3-6BH
Tapping Screws.

*The frame mounted
here differs from that
used in the previous
process. Please
recheck.

2.3-6BH
Tapping Screw

Leg Joint L

Mount one YHR-012_Leg
Joint L using two 2.3-6BH
Tapping Screws.

Se

e

2.6-10 Tapping Screw.

Tapping Screw

cure using one

2.6-10
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Assembly

®

Unscrew three of the case screws from Servo
Motor [ID 9] (green), as shown in the figure.

Insert the servo so that the YHR-012_Leg
Joint L is on the output axis side of the servo
and the YHR-013_Leg Joint R is on the
bottom side of the servo. Secure using the
three servo case screws taken off on the
bottom side, and three 2-5 Low Head Tap-
ping Screws on the output axis side.

Secure the YHR-014_Leg Joint B using four
M2-4 Low Head Screws.

* If you find it difficult to mount Leg Joint B,
loosen the three 2-5 Low Head Screws
first, and then retighten.

~

Servo Case
Screw

/,
2-5 Low Head AN 2
. /, T
Tapping Screw PR A

Servo Case
Screw

Low Head
Screw
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Assembly

14. Assembly - Sole

e Required Parts

[ |

Sole S-02 2 . -
YHR-015_Foot Angle A-L ---------- 1 .- ]

HH
YHR-016_Foot Angle A-R --------- 1 3 = = 5
e Angle o 1 Completed Process Image
YHR-018_Foot Angle B-R --------- 1
M2-6BH Screw 8
M2 Nut 8

@ Mount one YHR-015_Foot Angle A-L and one
YHR-016_Foot Angle A-R to two separate 9 M2 Nut
5-1924_Sole S-02s using two M2-6BH
Screws and two M2 Nuts each.

Foot Angle
A-L

M2 Nut @ Sole S-02

Foot Angle

Accordingly, mount one YHR-017_Foot Angle
B-L and one YHR-018_Foot Angle B-R using
two M2-6BH Screws and two M2 Nuts each.

Sole S-02

Use of screw locking adhesive is recom-
8 M2-6BH Screw mended if the nut loosens.

- J
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Assembly

15. Assembly - Front Cowl

e Required Parts

Base Plate A 1 - [ | .
Front Cowl (SD1) 1 .- ]
ig =l
Battery Holder A 2 3 ] s
i | N |
2-8 Low Head Tapping Screw ----- 4 iy

2-5 Low Head Tapping Screw ----- 4

/

Secure two Battery Holders on one Base Plate
A using four 2-8 Low Head Tapping Screws.

* The concave side of the base plate should
face inward.

Battery Holder A

2-8 Low Heat &
Tapping Screw Base Plate A

Secure the Front Cowl (SD1) to the unit as-
sembled in step (1) using four 2-5 Low Head
Tapping Screws.

2-5 Low Heat
Tapping Screw
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Assembly

16. Installation - Units (Head - Torso)

e Required Parts

Chest Unit [Process 4] ------------- 1 .ﬁ.
Shoulder Servo Arm [Process 5] -- left, right 1 each = 3 =
Small Diameter Horn --------------- 1 Q = = "
Head Base A 1 =i

2-5 Low Head Tapping Screw ----- 4
M3-8 Low Head Horn Fixing Screw--- 3

completed. If the Origin Setting has not been completed, go back to

The following processes require servo motors with the origin setting
"1'
[Process 2] “Setting Origin,” and do so prior to proceeding.

@ Insert the Small Diameter Horn as indicated in M3-8 Low Head
the figure and secure the Head Base A over it Horn Fixing Screw
using four 2-5 Low Head Tapping Screws.

(You may secure the Small Diameter Horn
and the Head Base A with 2-5 Low Head
Tapping Screws beforehand.)

2-5 Low Head
Tapping Screw

Secure one M3-8 Low Head Horn Fixing Screw

t th ter of the Head Base A.
at the center of the Head Base Head Base A
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Assembly

4 )
@ Insert the Left Shoulder Servo Arm as- @ Insert the Right Shoulder Servo Arm as-
sembled in process 5 to the Servo Motor [ID sembled in process 5 to the Servo Motor [ID
1] (red), and secure using one M3-8 Low 1] (blue), and secure using one M3-8 Low
Head Horn Fixing Screw. Head Horn Fixing Screw.

*® Cd

M3-8 Low Head
Horn Fixing Screw

View from left side View from right side

Shoulder Servo Arm Shoulder Servo Arm
(left) (right)
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Assembly

17. Installation - Units (Arm, Left)

e Required Parts
Chest Unit [Process 16]
Elbow Unit L [Process 7]
Arm Unit L [Process 9]
Upper Arm 2500A
M3-8 Low Head Horn Fixing Screw--- 2
2.6-10BH Tapping Screw
2.6-6 Flat Head Screw

<GS En

el | | ]
[ [ ]]
[ [ ]]

Completed Process Image

4 )
@ Insert one Upper Arm 2500A into the Servo @ Insert one Upper Arm 2500A into the Servo

Motor [ID 2] (red) and secure using one M3-8 Motor [ID 4] (red) and secure using one M3-8

Low Head Horn Fixing Screw. Low Head Horn Fixing Screw.

* Upper Arm 2500A must be secured * Upper Arm 2500A must be secured

straight in relation to the servo motor. straight in relation to the servo motor.
Upper Arm
2500A 5
N
Y
M3-8 Low Head ¢f
Horn Fixing Screw
M3-8 Low Head
Elbow Unit L Horn Fixing Screw
Od
Upper Arm 2500A
Insert the left arm part of the Chest Unit assembled in
Process 16 to the Joint Base part. The parts will click
to fit if the connecting part of the upper arm is first
inserted to the base and then lifted towards the servo
bottom.
- /
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2.6-6 Flat Head

-l
b~
[=
2
£
fu
<

Insert the left arm part of the Arm Unit as-
sembled in Process 9 to the Joint Base part.

®

2.6-6 Flat Head
Screw

Secure using two 2.6-6 Flat Head Screws on the bottom
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Assembly

18. Installation - Units (Arm, Right)

e Required Parts

Chest Unit [Process 17] ------------ 1 .ﬁ.

Elbow Unit R [Process 8]----------- 1 [ | - =

Arm Unit R [Process 9] -~----------- 1 ] ==

Upper Arm 25004 -----o--oroeoeees 2 =i B Completed Process Image
Face (SD1) 1

Visor (SC1) 1

Helmet (SD1) 1

M3-8 Low Head Horn Fixing Screw--- 2

2.6-10BH Tapping Screw ---------- 2

2.6-6 Flat Head Screw ------------- 2

2-8 Low Head Tapping Screw ----- 5

@ Insert Upper Arm 2500A into the Servo Motor
[ID 2] (blue) and secure using one M3-8 Low
Head Horn Fixing Screw.

Upper Arm Elbow Unit R

*Upper Arm 2500A must be secured
straight relative to the servo motor.

M3-8 Low Head
Horn Fixing Screw

@ Insert the Upper Arm 2500A into the Servo
Motor [ID 4] (blue) and secure using one
M3-8 Low Head Horn Fixing Screw.

*Upper Arm 2500A must be secured
straight relative to the servo motor.

M3-8 Low Head

Horn Fixing Screw
Upper Arm

2500A
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sembled in the previous process to the Joint

Base part.
Insert the right arm part of the Arm Unit as-

Insert the right arm part of the unit as-
sembled in Process 9 to the Joint Base part.

Arm UnitR

©)
®

60

>
e
=
0
7).
7
<




>
9
=
0
7).
7
<

Mount the Visor (SD1) to the Face (SD1) using

two 2-8 Low Head Tapping Screws.

Secure using two 2.6-6 Flat Head Screws on

the bottom side.

@

Face

2-8 Low Head
Tapping Screw

2.6-6 Flat Head

the Helmet (SD1) and secure using three 2-8

Sandwich the Head Base with the Face and
Low Head Tapping Screws.

©

* The protrusion on the Head Base should

fit the Face and Helmet.

2-8 Low Head
Tapping Screw

W55\
L7 BTN
==

LX)
(e
L7
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Assembly

19. Installation - Units (Leg 1)

e Required Parts

Servo Arm [Process 6] ------------- 4 . [ | "

Thigh Unit L [Process 10] ---------- 1 .- ]

Thigh Unit R [Process 11] ---------- 1 3 HE 5

i | N

Leg Unlt L [Process 12] ------------ 1 completed Process |mage
Leg Unit R [Process 13] ------------ 1

Upper Arm 2500A -------=-=-------- 6

M3-8 Low Head Horn Fixing Screw--- 6

2.6-10BH Tapping Screw ---------- 6

2.6-6 Flat Head Screw ------------- 6

@ Mount the Upper Arm 2500A (one each) onto Right (R) Side Left (L) Side
the Thigh Unit L and the Thigh Unit R, and
secure using M3-8 Low Head Horn Fixing
Screws (one each).

M3-8 Low Head
Horn Fixing Screw

@ Mount the Upper Arm 2500A (one each) onto
the Leg Unit L and the Leg Unit R and secure
using M3-8 Low Head Horn Fixing Screws
(one each).

Right (R) Side Left (L) Side

62



Assembly

/

~ \
3 2

Attach the Leg Unit L to the Thigh Unit L, and
the Leg Unit R to the Thigh Unit R.

Right (R) Side Left (L) Side

Secure one 2.6-6 Flat Head Screw on each
Bottom Arm 2500A.

Right (R) Side Left (L) Side

2.6-6 Flat Head Screw

\

Secure the connecting parts using one 2.6-
10BH Tapping Screw for each.

Right (R) Side Left (L) Side

@ Attach the Servo Arm to the Upper Arm.

Servo Arm

Servo Arm

Right (R) Side Left (L) Side

J
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Assembly

/
@ Secure the connecting parts using one 2.6-
10BH Tapping Screw for each.
y n h‘”ﬁ
® { i
e 1
AN
Right (R) Side Left (L) Side
Secure one 2.6-6 Flat Head Screw on each
Bottom Arm 2500A.
0 Jum 2k 0)
2.6-6 Flat Head 2.6-6 Flat Head
Screw Screw
04 — @
Right (R) Side Left (L) Side
\
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Assembly

20. Installation - Units (Leg 2)

* Required Parts

Foot Unit L [Process 19] ----------- 1
Foot Unit R [Process 19] ----------- 1
Sole L [Process 14] ----------------- 1
Sole R [Process 14]-----------=----- 1

Servo Motor KRS-2552 [ID 6]------ 2
Servo Motor KRS-2552 [ID 10] ---- 2

YHR-006_Servo Bracket A -------- 4
Small Diameter Horn  -------------- 4
Free Horn 4
M3-8 Low Head Horn Fixing Screw4
2.6-6 Flat Head Screw ------------- 4
2-5 Low Head Tapping Screw ---- 56
M2-4 Low Head Screw------------- 8

el | ||
[ [ |
ll -
[ [ []
<SEE

Completed Process Image

@ Mount one Small Diameter Horn each on
Servo Motors [ID 6] (yellow), [ID10] (yellow),
[ID 6] (green) and [ID10] (green), and secure
using one M3-8 Low Head Horn Fixing Screw
for each.

@ Mount one Free Horn each on the bottom
side of all four servo motors and secure
using one 2.6-6 Flat Head Screw for each.

M3-8 Low Head
Horn Fixing Screw

Small
Diameter Horn

~0
o
A
e
Q,
%

s
S Cfi
7
7

2.6-6 Flat Head
Screw

Free Horn
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Assembly

/

@ Remove two servo screws as indicated in the
figure.

HE. - Hifl. -

Secure four Servo Bracket A to the Servo
Base 2500A using six 2-5 Low Head Tapping

Screws for each. Be careful of the orienta-

tion.

2-5 Low Head
Tapping Screw

Right (R) Side

7% %

Left (L) Side
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Assembly

Secure each Servo Motor to the Servo
Bracket A using the four servo screws
removed and four 2-5 Low Head Tapping
Screws.

Servo case
screw

Servo case

Right (R) Side Left (L) Side

Motor

Right (R) Side Left (L) Side

2-5 Low Head

Tapping
Screw

2-5 Low Head
?)  Tapping Screw

Right (R) Side Left (L) Side
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Assembly

4 )

@ Mount each sole. Secure the Small Diameter Horn using four M2-4 Low Head Screws each and the
Free Horn using four 2-5 Low Head Tapping Screws. Check the direction of the protrusion on the
Small Diameter Horn. If the protrusion is not as shown in the figure, turn the Small Diameter Horn by
hand to match the figure.

4 \‘\

\/"

Right (R) Side

Left (L)

Right (R) Side

Side

Low Head

M2-4 Low Head Screw

Screw

2-5 Low Head
Mount both legs on the Hip Unit. Both the / .. Tapping Screw
Small Diameter Horn and the Free Horn i \
should be secured using 2-5 Low Head Tap-
ping Screws (4 each). "

2-5 Low Head
Tapping Screw

°* This hole is on the
back side. Make
sure the Free Horn
is on this side.

Right (R) Side Left (L) Side
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Assembly

21. Wiring and Binding of Wiring

e Required Parts

Cable Guide 8
Cable Guide (small)----------------- 6
M2-4 Low Head Screw------------- 4

2-5 Low Head Tapping Screw ----- 4
2-6 Flat Head Tapping Screw ----- 8

4 )

@ Wire the Arms in accordance with the wiring diagram.

ZH Connection Cable A ZH Connection Cable A
(ZH/ZH connector) (ZH/ZH connector)
200 mm 200 mm
/ @ /

ZH Connection Cable B —_|| o=l ° ¢ o ° o ZH Connection Cable B
(ZH/Servo Connector) Da e m M (ZH/Servo Connector)
300 mm —+ ga| e _e o 300 mm
_ D a _

ZH Connection Cable A 9 @ ° o |_UI— ZH Connection Cable A
(ZH/ZH connector) o o o (ZH/ZH connector)
100 mm 3 100 mm

==|  *View from backside

69



Assembly

4 I
@ Organize the cables using the Cable Guides and the Cable Guides (small), in accordance with the figure.
Cable Guide Cable Guide
| 2-6 Flat Head 2-6 Flat Head
Tapping Screw Tapping Screw
s E'H =
1”—\ -
© i
N
Cable Guide
(small)
M2-4 Low Head
Screw
\
Cable Guide
4 (small)
; @\@
M2-4 Low Head
Screw
\ J
\ J
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Assembly

/

Leg Wiring Diagram

Wire the Legs in accordance with the wiring diagram.

* View from backside
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Assembly

/

@

Mounting Cable Guide (6)

Mount Cable Guide in accordance with the figure.

2-6 Flat Head
Tapping Screw
(one each)
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/

Mount Cable Guide (small) in accordance with the diagram.

(B) Mounting Cable Guide (small) (4)

* Backside View

)
i)
> =
O ©
o £
oL
©
(6]

2-5 Low Head
Tapping Screw (4)

gl

M2-4 Low Head
Screw (2)
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Assembly

4 )

@ Bundle the cables using the Nylon Straps.

74



>
9
=
0
7).
7
<

3 k]

: 3
o T Y
o 2
n 2o /

o = =
Q - 9 . \S -\
2 30\ e S Nen.
T _ 7/ N NN
o Nl LT AY
| NQw2 ..‘\\\ < «‘zoﬂ \!&(% N
<r _»,,v,n. [©) N \ .‘ﬁz{ﬁ‘ ), ﬂﬂi‘nltl PN
W_ ) R \ ! \\ ) .
X £
n o
[)) . o)
£ =
) . A oy
M 4 u‘_ .«n._. \/ /> o /@V,@"E‘M\ = .

IR e o/ NS AN > TSR \Z

N S
[0} VA= .\\\\s - ./.,{,. ,v..,l_ Y, FN\\I/JMW-
’ flon 25
@ e ®

- 4
M2-4 Low Head
Screw

it 5
> m a
Q | 3
£ m o
[0 | e}
» = +
7)) o g B S
A & > / %MML
=| 27 < ot B
(0] - &
© e T 5
(V] T =2 2
nw 239
=
ol &8 ©
AN ° \_

75




PCB Base B

2-5 Low Head
Tapping Screw

.|.F||.\Fu N

ST
E.!N v.<|

\/-

Retainer B

*There is a front side
and back side on Re-
tainer B. Mount as

6

2-8 Low Head Tapping Screw ----- 2

Power Switch and Ex-

tension Cord used for Origin Setting.

Back Pack
2
1
1
1
1
1

4HV,

Mount two Retainer B using two 2-5 Low

Head Tapping Screws for each.
Route the cables as shown in the figure and

mount the PCB Base B to the back of the

body using four M2-6BH screws.

Unplug the RCB

@
@
€)

2-5 Low Head Tapping Screw ----- 4

HV Power Switch Harness --------- 1
Servo Extension Cord-------------- 1

e Required Parts
Retainer B
PCB Base B
Top Panel B
Top Cover B
Wing B-L
Wing B-R
M2-6BH Screw

23. Attachment -

>
e
=
0
N
7
<
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Plug the Power Switch to the Top Panel B.

(Push until it clicks firmly into place.)

@

HV Power Switch Harness

o
©
c
©
o
&
[

Insert the Top Panel B to the top of PCB

Base B.

®

and secure it using two M2-6BH screws to

Plug the Extension Cord to the port entrance
avoid loosening.

®

Top Panel B

Servo
Extension Cord

Screw

-8 Low Head Tapping

Secure using two 2

Screws.

-L and the Wing B-R onto

Top Cover B and insert it into the top of the

Hook the Wing B
PCB Base B.

@

2-8 Low Head
Tapping Screw
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Assembly

24. Mounting Control Board

e Required Parts

Parts Mount A 2
RCB-4HV 1
2-8 Low Head Tapping Screw ----- 8
2.6-6 Flat Head Screw ------------- 2

/

\_

Put the HV Connector inside the body as
shown in the picture.

?

2.6-6 Flat Head Screw

Close both wings and secure using two 2.6-6
Flat Head Screw.

Open the Wing and mount the RCB-4HV
using eight 2-8 Low Head Tapping Screws so
that it comes between the PCB Base B and
the Parts Mount A.

2-8 Low Head
(] Tapping Screw

Parts Mount A

RCB-4HV
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Assembly

25. Wiring to the Control Board

e Required Parts

2-5 Low Head Tapping Screw ---- 4
Board Cover (SD1)------------------ 1

@ Plug in the Servo Connector, Power Con-
nector and Extension Cord to each port ac-

cording to the wiring diagram. SIO Port
* Make sure the signal cable (white) faces >
inward. ﬁ@ o

Power Terminal

Al
(Analog Input Port AD port) W\
* Not Used presently. Md\w /

2-5 Low Head
Tapping Screw

Secure the Boar
Tapping Screws.

*When the cove
two 2.6-6 Flat
unscrewed.

. °{/ COM Port

*Plug so that the signal cable
(grey) faces inward.

second pin from top

* Make sure the
signal cable (white)
faces inwardly.

(P1O Port)
* Not Used presently

d Cover using four 2-5 Low Head

r is opened, these screws or the
Head Screws on the Wing are

J
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Assembly

26. Battery Mounting

e Required Parts
Charged HV Battery

4 )

Plug in the HV Connec-
tor for Power.

@ Insert the Battery. Tilting the connector upward as shown in the picture makes it easier to insert.

@ Fit in the Front Cowl by sliding it in. @ Fasten four Body Pins as shown in the dia-
gram.
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Setting

Trim Position Confirmation

What is the Trim Position?

Up to this point, for the assembly of all units, the servo
horns and servo arms were assembled at their origin
(neutral position). This process is to confirm that the
origin is accurately read out and that the horns and
arms are mounted correctly.

If the Trim Position is set normally, proceed to set the
Home Position by the following steps. “Trim Position”
and “Home Position” are confusing concepts, but are

1 Connect the Serial USB Adapter HS Cable.

Connect the Serial USB Adapter HS Cable
plugged from the computer to the port connector
at the top of the Back Pack.

2 Run the ‘HeartToHeart4’ software application.
3 Turn the KHR-3HV power switch on.

4 Open “Neutral Setting” project.
The “Neutral Setting” project created during the
Origin Setting process is used.

Select “File” > “Open” > “Project” > “Neutral Set-
ting” > “Neutral Setting .xml”

* Under standard conditions, the HeartToHeart4
folder is created in My Documents.

If project is opened normally, the following will
appear at the bottom of the software window.

very important for robots. “Trim Position” refers to the
state where trim data is “0” and position data is “7500” ,
and servo motor is at its origin. On the other hand, the
“Home Position” refers to the Robot’ s original posture
(position) for the “Sample Motions” of this product to
operate normally. To operate the sample motions cor-
rectly and to improve their reproducibility, the “Home
Position” setting becomes very important.

ﬂ% Heart To Heart 4
Dok AJLTH)

R ;
T ) EESETN
E-va D cubs | L] E-vavw

LA CRETE DT TIRTF A
ETOE-VI%RTE GtrbShift+

= FOYVIORERTEE
BEEINITIOV OEIRTE

T

7 )b G¥Dacuments and Settings¥Administratar¥My Documents¥Heart ToHeartd¥Praojects¥ "1 — FRILERTEY . 1 — FRIERTE xml MERHIAMITE T LELE.
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5 Assign Communication Port (COM) Number

* Here, COM10 is used as an example.
15 Heart To Heart 4

6 Select “Project Setting” E Heart To Heart 4

* An error message (shown in the right figure) ap- T5— (X
pears when there is no communication for rea- —
sons such as robot not turned on, or communi- e T BOBIE (R 2L, COMME — MDA EREILT L,

cation port (COM) number not being selected.

The following window appears when normal com-
munication is established.
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7 Set ICS communication rate to “115200”

8 Click “RAM” button.

The robot will slowly move to its trim position.

* RGB4 7, F 1A LEE

ﬂr RAM f ROMAIZTE - NGEET 9 Za—b3ik X 74—<wh Wuas—h

10me | COMBEEE [1260000 v ICSREEE

[] #LED B F-IER [ Ehf'efs T OEE ROMINEEED H-tahiEaTRE

When the RAM button is clicked, the robot will
assume this posture. If this is not the robots
pose, then the origin setting is incorrect and
must be adjusted before proceeding. Retrace the
origin setting steps for the part of the robot that
doesn’ t match the posture shown.

Proceeding to set the Home Position without con-
firming this posture can cause damage to the
servo motor. Make sure this posture is assumed
by the robot before continuing on.
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Setting the Home Position

As in the preceding steps, the Home Position is set using a personal computer. The robot will finally move when this

setting is completed.

1 Click “File” > “New Document” > “Project” in
order.

2 In the New Project window, name the new project
“Hello_KHR3” and click the Project Import button.

*The New Project may be named arbitrarily. Do
not change location of file unless necessary.
Under standard conditions, projects are saved in
the HeartToHeart4 folder in My Documents.

3 Select “Hello_KHR3” in “Projects” from the
“HeartToHeart4” folder created in “Program
Files” , and click “OK” .

* Unless changed after installation of software,
“HeartToHeart4” folder should be found in
“C:\Program Files” .

4 Return to the New Project window and click
“OK” .

5 Assign a Communication Port (COM) number in
the main window.

* This step is unnecessary if it has already been set.
* Here, COM10 is used as an example.
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6 Select “Project Settings” .

* An error message as shown in the right figure
appears when the robot is not turned on, or the
communication port (COM) number is not se-
lected.

The following window appears
when normal communication is
made.

7 Set the ICS communication rate to “115200” .

* This step is unnecessary if it has already been

set.

#8 Heart To Heart 4

703 tH MR

Cr¥Dacuments and

6 T —ROFSCERLE L, COMA — OISR 2L T 5.

| | woaez |

[ ROmnEFEED [#] #—&hi'EaTER

85



8 When the “RAM” button is clicked, the project
standard values are sent to the RCB-4 and the
robots servos will operate.

The robot will slowly move to its Home Position.

When the RAM button is clicked, the robot will
assume the posture indicated in this picture. This
Home Position is a rough approximation and may
differ slightly depending on the method of assem-
bly. (* It is necessary to be as close as possible.)

The posture offset is adjusted by the steps indi-
cated in the following section.

If the position assumed is not as shown in the
graphic (upright position), there may have
been a mistake in the servo mounting during
the assembly process, for example. Check
the servo IDs with reference to p. 18 “List of
KHR-3HV IDs” in detail.

9 Choose the servo motor you want to adjust in the oA
- . . 8101234 FER -+ -81012,3,4 D : -as ne
“Servo Motor Initial Setting” section. P r :

The servo motor [ID 0] (red) connected to SIO1 T ST
channel is used as an example.

My 700 &
-

10 Press “Sync” button and adjust using “Trim” slide NIYN
bar.

* The servo will move in sync with the slide bar.

{1 Adjust the other servos using the same steps.
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Adjust the position of each servo in the open adjustment window and adjust the Home Position. Home Position is
defined as the upright standing position. Home Position is an important position and becomes the base or reference
point in performing motions. In particular, the left and right feet must be aligned accurately or else sample motions
such as walking may not proceed smoothly. Align the robot servos accurately by referring to the following picture.

______________________________ y

k& g

The position of the back side of the feet is especially There are marks (holes) called Neutral Gauge on each

important. Stability can not be obtained unless both frame. Aligning this mark and the protrusion on the arm

feet are aligned. can be used as a reference indicator for the Neutral Po-
sition.

"1.

The output axis of each
servo on the leg/feet should
form a straight line when
seen from the side.
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12 After setting each servo, select “Save All” in “Save to ROM” .

* clicking this button sends data to the robot and Home Position is recorded.
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CEw ] (foorw |
)

14 Return to the Main Window and press “Save Project” .
* clicking this button saves data in the computer, making it possible to read this data next time.

E Heart To Heart 4
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Ca

15 In order to confirm the setting process was successful, turn the robot OFF and then turn it ON again. If the robot
slowly moves to the set position, the Home Position Setting was successfully completed.
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Playing Sample Motions

Load and play the sample motions for KHR-3HV. If the robot falls or does not move normally, go back to "Home Position Setting".

1 Click “File” > “Open” > “Project” in order. [ Heart Ta
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* If the Motion List window is not displayed, press
the Display Motion List button in the top left
corner of the screen.
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3 Press the "Write Motion Data" button in the

Motion List.

* When the write is completed, the Write Comple- rﬁ? If_fl]]m shie BEIQJ
tl;'thtatus will appear at the bottom left corner MIZ  HLOODZ 7 darei s (Hello KHR) 70
of the screen. MOZ  HLOODZ F%iE3 12

MO4  HLOODM TAT-7— 1%

MOG HLODDE_'@%'%@ 22:

MA0G HLODO0G_ 1% o

| = — MOT M7 32
[EERNRREREEH N R R R E—aT -8 EEAHBFET - p MOE  HLOODS 383 <M400ET iR L _hrae 41 0] KF|
N M9 HLOO09_ = =+-38+ (MA0nETr R Lo 411

M10  HLODTO0_ sy TiAE Ghrr A1 0mh 1y

M1 HLODT R RE{ER 45 51t

M12  HLODZ AR AC 350D 56

4 Click the motion name you wish to play in the
Motion List.

MOS  HLOODS | A% 22
MOE  HLOODG 5E375 20
MO7  MO7 =
MOE  HLOODS 3B (MADBETFLL A0 97
M09 HLOOO9 = =+48F (M4O0FETFE L) 411
MI0  HLOOTOBRET T (A chry41 00 467
Mi1 HLOOT B BB chr 450E]) Bt
M2 HLODT2 PR A A3 B

5 Press the Play button in the Motion List window.

* Caution! The robot will actually start moving
once the Play button is pressed.
HLOO0 &1
MOZ  HLOODZ R —Lafii gz (Hello_KHRS Rl
M2 HLODOZ FEIES 12
MO4  HLOODA T4 TA7- 1%
MO5  HLODDS [E LA 22
MOE  HLODDE J¥37% 2%
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MI0  HLOD ORI TiA G 41 00E] 46
M1 HLOON B E i ihrs: 5l Bt
M12Z  HLOMZ rt ket A chra: AafE) s

To play other motions, repeat steps 4 to 5. If you wish to stop the robot, press the Stop button.

That completes the instructions on assembly and motion production. For the software op-
eration instructions, refer to the “HeartToHeart4 User’ s Manual” document file.
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